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DEMAND MANAGEMENT MODULE

Demand Management is the component of PPM Center that manages requests from creation to implementation. 

Each request is processed using a workflow that is represented graphically in the user interface. 

Demand Management can follow complex business rules by using different approval methods.

Email and pager notifications can be generated as the request passes through the various workflow

steps. Prioritization and delegation features allow requests to efficiently advance through the

workflows applied to them, routing them to the relevant department, group, or individual.

A Demand Management request resolution system is used to track requests from their creation to

their resolution. The main components of a request resolution system are requests and workflows.

Requests are the fundamental work unit in Demand Management. When you ask for help, you

create a request. When you report a problem, you create a request. When something needs to happen,

you create a request.



DEMAND MANAGEMENT MODULE

After you create a request, it must follow a process to reach its conclusion. A workflow is the process a

request takes to reach its conclusion. Workflows consist of workflow steps, and each workflow step

corresponds to a decision or action.

At each workflow step, information can be added to the request or existing information can be updated.

For example, you might create an enhancement request to ask for a change to an application. Later in

the request resolution process, after the enhancement request is approved, developers are assigned to

work on the enhancement.

In PPM Center, you interact with the request through the request detail page. The detail page displays

all the information about the request. This is where you make decisions about and act on the request.

After the decision is made or the action completed, the user must manually access the request detail

page and select the decision or action. The request then advances to the next step in the workflow, at

which another user makes a decision or takes an appropriate action.





RESOURCE MANAGEMENT MODULE

This component is part of PPM Center and provides an array of tools for managing personnel related to IT initiatives.

-Role and skill modeling capabilities unlock the potential of resources, 
while regional calendars make it easier to accurately determine available working hours as well as holidays and vacations. 

-Organizational modeling capabilities keep track of where resources are located and who they report to. 

-As resources are assigned to tasks and requests, executives and managers have full visibility into the capacity of their teams and the 
load placed on them, in terms of both current execution and capacity planning for the future.

-To support future demand and project planning, resource forecasting capability is achieved with staffing profiles and resource pools. 
High-level visualizations help program and resource managers with assessing project feasibility and timing, 
and with making advance staffing decisions and allocations. 

-To support current demand and project planning, Resource Management delivers a set of visualizations and related tools that managers 
and individual resources can use to communicate each others' needs and capabilities. 
These include work calendars, standard planning fields on tasks and requests, and resource load and capacity histograms.





FINANCIAL MANAGEMENT MODULE.

PPM Center features a set of functionality collectively referred to as Financial Management. 

Financial Management enables you to do the following:

1-Set up and use cost rules to provide detailed estimates of labor costs

-Cost rates can be based on a number of different cost factors.
-Cost factors can be organized by order of precedence.

2-Use and display multiple currencies in one installation of PPM Center

-Currency display can be user-based or entity-based.
-Currency values are tracked against each other using financial exchange rates.

3-Use financial summaries to track forecast and actual costs and benefits and approved budgets for lifecycle entities and programs over a range of years, and to track 
approved budgets for organization units over a range of years. You can also take snapshots of the financial summaries and specify one as the Plan of Record at any time.

-Forecasted labor costs in the financial summary can be rolled up (automatically calculated) from the staffing profile.
-Actual labor costs in the financial summary can be rolled up from time logged on time sheets if Time Management is used, 
and also from project work plans if Project Management is used.
-Actual non-labor costs in the financial summary for a project can be rolled up from the project work plan if Project Management is used.
-A program roll-up financial summary is the summation of the financial summaries of the projects in the program if Program Management is used.
•



FINANCIAL MANAGEMENT MODULE.

4-Configure, create, and use financial data tables to track forecast and actual costs and benefits for any type of request, 
including but not limited to lifecycle entities. Financial data tables are used to track forecast and actual costs and benefits 
for such purposes as tracking indirect costs and/or benefits.

5-Track and analyze project cost data if Project Management is used.

-Planned and/or actual costs on the work plan can be calculated automatically using scheduled and/or actual effort specified 
for work plan tasks and using labor cost rates.

-Earned value (EV) analysis can be performed on project cost data.

6-Monitor SOP 98-1 compliance.

-Capitalization can be tracked at the task level using activities.

-Capitalization can be built into processes using project templates.

-Capital exposure can be monitored at the program and portfolio levels.





TIME MANAGEMENT MODULE.

Time Management is an PPM Center application that allows resources (users such as yourself and your colleagues) to use time sheets to report 
how long they worked on specific "work items." Work items are categorized in Time Management as requests, projects, tasks, packages, or other 
miscellaneous types of work. Planners or operations managers assign work items to specific resources. 

Resources can also use the My Tasks portlet to report work they have done on tasks in projects.

On an ongoing basis, the time sheets for a resource cover a consistent reporting period, such as weekly or semimonthly. At the end of each 
reporting period, resources submit their time sheets for approval. Designated approvers then review and approve the reported time. Project 
managers can compare reported "actuals" to previously estimated time and associated costs.

Depending on your responsibilities, you can use Time Management to do the following:

-Create and manage time sheets (many resources will use Time Management for only this purpose)

-Review and approve time from time sheets

-Freeze and close time sheets

-Create work allocations for packages and miscellaneous items, if needed.

-Compare actual time reported by users against estimated time and associated costs.

Time Management uses time sheets to efficiently manage the time reporting and approval process.

Time Management process, and subsequent sections outline the steps and the people involved in the process.

Most Time Management users are resources assigned to specific work items who complete time sheets to report their time, 

submit their time sheets for approval, and occasionally rework or cancel their time sheets.





Administrator’s Console
This tool allows PPM administrators to manage PPM configuration internally.



Workbench
This tool allows PPM administrators to manage PPM modules.



PPM 50 HINTS AND TIPS



1- PPM ADMINISTRATOR PASSWORD RESETTING.

How to proceed when the administrator’s password is not available 

because the resource left the company or simply it was forgotten.

We can reset PPM administrator password whether it is not available.

In order to update knta_users table with new encrypted password please follow the below steps.

1-back up the knta_users table.

2-go to PPM_HOME/bin and run kEncrypt.sh script, enter new password to generate the encrypted string

3-copy the string without initial and final delimiter #!#  

4-update the knta_users table as shown below.

Sample:   update knta_users set password='<recently copied string>' where username='admin’;

5-start PPM and log in with the new administrator password.



2- CUSTOMIZING MENU ITEMS 

From PPM 9.54 you may want to customize the PPM menu, I mean, deleting, adding or changing existing menu. 

We strongly recommend that you never edit the menu.xml file to customize the PPM menu, although this method still works.

By changing the menu.xml file, you will lose any menu change introduced in PPM new versions, unless you manually reconcile the changes into your 

customized menu.xml file after each upgrade. 

Instead, you should follow the process below to customize the PPM menu. 

This process does not overwrite menu.xml updates and makes it explicit what changes are done to the PPM menu.

-Leave the /conf/menus/seed/menu.xml file untouched.

The menu.xml file is moved from conf/menus to /conf/menus/seed since 9.54. You should never modify it. 

-If you want to delete an existing menu item, edit the /conf/menus/custom/delete_menu.xml file.

-If you want to add a new menu item or update an existing menu item, edit the /conf/menus/custom/update_menu.xml file.

-Flush the caches to make the changes to menu xml files take effect.

-When loading the menu, PPM first loads the built-in menu.xml file, then applies the delete_menu.xml file, and then applies the update_menu.xml file.

To make sure your menu customization remains on every PPM upgrade, replace the update_menu.xml and delete_menu.xml files 

with your own custom versions after upgrade.



3- WORKFLOW CHANGES FOR ACTIVE REQUESTS.

Can users modify a workflow with existing requests using that workflow ?

Users need to be aware of the consequences of any workflow changes in the existing requests that already use that workflow.

If users modify a workflow with existing requests using that workflow, they would see a warning message stating the below.

The current workflow is already in use. Any changes may result in data loss.(KWFL-30077)

Even Though data loss may happen for existing requests,

it doesn't mean that expert users are unable to modify a workflow which is already in use,

However, they would proceed at their own risk.



4- USE REFRESH BUTTON TO RELOAD PAGE

Is there a best practice to reload PPM page ?

We enforce POST method for state-changing PPM web service requests to protect PPM from attacking.

As a result of this protection, Pressing Enter in the address bar is not allowed and returns 403 error.

Therefore, we recommend you use the Refresh button if you want to reload a page.



5- EXTERNAL WEB SERVERS

Why an External Web server would be required?

PPM comes with an internal Web server to handle HTTP requirements in many implementations.

However, an External Web server is required in the following situations:

-PPM is deployed as a cluster configuration and you do not want to use a hardware load balancer to distribute the load.

-HTTPS is required to access PPM.

-PPM Server is running on a UNIX platform and the HTTP port number must be lower than 1024.

-Integration with a single sign-on system that utilizes the PPM Web Server Module (such as CA SiteMinder) is desired.

Note: an external Web server does not have to be installed on the same machine as the PPM Server. 



6- RESOURCE USAGE VIEW CALCULATION.

How the Resource Usage view is calculated ?

The Resource Usage page for a work plan allows you to view the load placed on each resource that is assigned to the work plan, 

broken down by task by period.

1.Regarding Scheduled Effort used in Resource Usage: please refer to "Cost and Effort" section of project settings, 

it provides options for "Scheduled Effort in the Work Plan".

For instance, if "Automatically calculate Scheduled Effort" is selected, 

PPM uses working days which between task schedule start and schedule finish date to calculate efforts.

2.Regarding  Actual Effort used in Resource Usage: please refer to "Cost and Effort" section of project settings, 

it provides options for "Actual Effort in the Work Plan".

For instance, PPM uses time sheet to get actual efforts if users select to Time Management to track actuals against the work plan.



7- CREATING WORK ALLOCATIONS FOR USERS

Managers or planners can optionally create work allocations for packages and miscellaneous work items, one per work item to specify the following:

-The amount of time allocated to be spent on a particular work item.

-Which resources (users) are allowed to spend time on the work item.

-The charge code or codes (with relative percentages) against which the time can be billed.

The work item must exist before its work allocation is create and specified, 

so that managers or planners can compare the actual time entered on the time sheet 

to the time specified in the work allocation, and this may influence their approval decisions.

-Work allocations for projects and tasks are superseded by the time assigned to projects 

and tasks when Time Management and Project Management are integrated using the Cost and Effort policy in project settings.

-Work allocations for requests are superseded by the assigned resources specified in request types

-We strongly recommend that you not use work allocations for programs, projects, tasks, or requests, 

but only for packages and miscellaneous items as needed.



8- INTEGRATING REQUESTS AND PROJECTS

Customers who have both Demand Management and Project Management can integrate Demand Management's request tracking capability with 

Project Management's deliverable date and actuals tracking capabilities. 

By integrating Demand Management and Project Management, requests can be folded seamlessly into a scalable framework of interlocking initiatives.

Linking tasks to requests from Demand Management also gives instant visibility into the detailed activities that support a project.

The possible relationships between projects, tasks, and requests are as follows:

-Reference Tasks to Requests. You can use the References tab on the Task Details page to link a task to new and existing requests.

-Reference Projects from Requests. You use the can use the References tab on the Task Details page to reference existing projects from requests. 

-Reference Tasks from Requests. You use the can use the References tab on the Task Details page to reference existing tasks from requests. 

As you integrate requests and projects, dependencies are established between the two entities. 

For example, you can specify a request as a predecessor to a package. 

This means that the package cannot continue along its workflow until the request is closed. 



9- PPM LICENSE TYPES

PPM offers you two types of user licenses: named licenses and concurrent licenses. You can install the license type that can best support your business.

Named license

A named license is individualized. Only the user named can access specific features of PPM. And the user can access PPM anytime and anywhere.

What features can named licenses cover

Configuration

User Administration

Application Portfolio Analyst

Application Portfolio User 

Demand Management

Deployment Management

Portfolio Management

Program Management

Project Management

Time Management



10- RUNNING PPM WORKBENCH WITH HTTP(S)

Starting from 9.40, PPM Workbench communicates with PPM Server via HTTP(S) by default, the same port that is used in communication between Web browser and PPM Server.

If you find PPM Workbench communicates with PPM Server using RMI(S) port, you can do the following to enable the communication via HTTP(S):

1.Stop the PPM Server.

2.Set the parameter ENABLE_WORKBENCH_HTTP to true in server.conf file. By default, it is true.

3.Provide a value in the parameter WORKBENCH_SERVICE_URL. 

This is the address of PPM Server with which PPM Workbench communicates via HTTP(S).

If the value of this parameter is null, 

the system uses the value specified in BASE_URL for the communication between PPM workbench and PPM Server via HTTP(S).

4.Run the kUpdateHtml.sh script.

5.Start the PPM Server.

Running PPM Workbench with RMI(S)

If you set the parameter ENABLE_WORKBENCH_HTTP to false, PPM Workbench communicates with PPM Server using RMI(S) port.

To run PPM Workbench as a Java applet with secure RMI:

Specify the complete RMI URL, in the following format, when you start the PPM Workbench: 

java com.kintana.core.gui.LogonApplet rmis://<Host>:<RMI_Port>/<KintanaServer>

You can type the RMI URL at the command line or, on Windows, specify it in a shortcut.



11- UPGRADE FAILURE TROUBLESHOOTING.

1-Implement the Back Out Plan, If an error occurs during a PROD environment upgrade, implement the Back Out Plan. 

2-Run kSupport.sh Script If the upgrade fails at any point, run the kSupport.sh script. 

This extracts relevant information about the problem from the database log tables and log files and generates an HTML file that contains the information.

The generated HTML file helps pinpoint the root cause by listing each upgrade task  and indicating whether he task was successfully run, failed, or was not run. 

It also includes the upgrade build number for reference. 

3-Check Upgrade Log Files

Upgrade log files are stored in the <PPM_Home>/upgrade_960/logs directory. 

The ppm_upgrade.log file in this directory may serve as an entry point, pointing you to other logs in the directory.

It is possible that you may need to run the upgrade process in several iterations. 

Every time you run an upgrade iteration, PPM will create a "run iteration number", so the ppm_upgrade.log file may point to a directory like this: 

<PPM_Home>/upgrade_960/logs/<Run_Interation_Number>. 

For example, your first upgrade iteration fails and you run the upgrade process again, then you should see the following log directories:

<PPM_Home>/upgrade_960/logs/1

<PPM_Home>/upgrade_960/logs/2



12- ABOUT PREVALIDATION

After you start the upgrade process, you have the option to run the prevalidation step. We strongly recommend that you select this option. 

Prevalidation checks for data inconsistencies that might cause upgrade problems. If you run prevalidation, the upgrade utility creates one or more html reports in the 

<PPM_Home>/PPM_Upgrade/upgrade_940/logs/reports/html/integrity/validator directory.

We recommend that, at a minimum, you start the upgrade just to run the prevalidation step for upgrades performed in advance of your production system upgrade. 

Running the prevalidation step can give you a good estimate of how long it takes to run prevalidation scripts against your specific data set.

If the time to execute prevalidation scripts against your environment 

consumes a significant amount of the time allocated for the production upgrade, 

then consider performing the prevalidation step and resolving any uncovered issues 

before you upgrade your production instance.

Prevalidation Reports

Prevalidation may generate several reports that list any problems detected, their cause, 

and any corrective action to take before you start the upgrade process. 

The warnings and errors in these reports indicate potential problems 

with data that may cause the upgrade to fail. 

We strongly recommend that you take corrective action for warnings 

and errors before you proceed to upgrade your PPM instance.

Note:  prevalidation also detects invalid configuration and insufficient database access rights.



13- UPGRADING A PPM SERVER CLUSTER

To upgrade a PPM server cluster, Tomcat clustering technology requires parameters that are specific to the cluster.

Without this configuration, all nodes would use the same default port configuration, which can lead to server startup failure or other problems.

To upgrade a PPM server cluster:

1.Make sure that you have set up a shared folder to give all nodes in the cluster access to the server.conf file. 

2.Stop all nodes in the cluster.

3.Perform the upgrade on the primary node in the cluster. 

Note: When you run the upgrade on the first server, both the file system and the database portions of the upgrade are executed.

4.If the nodes in the server cluster are hosted on multiple machines, run the upgrade on each host machine, one at a time.

After you configure the first server to include all additional nodes, 

a.Copy the entire <PPM_Home>/ directory from machine1 to machine2, to the BASE_PATH defined in the @node directive.

b.Zip the file, send it using FTP, and then unzip it at the destination.

c.After you copy the file, change the directory to <PPM_Home>/ on the new machine, and then rename the <PPM_Home>/server/node1 directory to 

<PPM_Home>/server/node2.

The server name must match the value set for the KINTANA_SERVER_NAME parameter.



Example:

the directories on machine1 could be:

<PPM_Home> 

+ server/ 

+ node1

The directories on machine2 could be:

<PPM_Home> 

+ server/ 

+ node2

d.Put a new license on machine2, as required by the new IP address. Run kUpdateHtml.sh on both host machines to apply the server.conf changes.

e.Repeat step a through step d on each of the remaining host machines in the cluster.

5.Restart the nodes, one node at a time.  

Caution: Make sure that you wait until each node is fully started before you start the next node.



14- HOW CAN CUSTOMER CHANGE THE DISPLAY FORMAT OF 

DATES, TIMES, NUMBERS, AND CURRENCY ?

You can change the display format of dates, times, numbers, and currency by editing the regional settings on the Regional Settings tab of the Edit My 

Profile page. 

These settings also determine the display of these items in email notifications by the system. 

Note for Windows only: to export data to Microsoft Excel or synchronize data with Microsoft Project, your PPM Center regional settings preference 

must match that of the Windows environment on which you are performing the data export or synchronization. 

This match ensures that Microsoft Excel or Microsoft Project can interpret dates and numbers correctly.

To set regional settings:

1.Log on to PPM Center.

2.From the menu bar, select Open > Administration > Edit My Profile.    Change your regional settings on the Regional Settings tab.

3.In the Use Default Options For list, select the locale (language name/geography) that you want to use for display of date, time, and currency values.

4.Click Done.

The new locale is accepted.



15- HOW CAN WE SAVE A SEARCH?

You can save and rerun commonly run searches for requests.

To save a search:

1.Log on to PPM Center.

2.Run a search.

The Search Results page loads, displaying the results of your search.

3.In the Save this search as field, enter a name for the search, and then click Save.

A window opens that displays the results of the save operation.

-Click Manage Saved Searches to go to the Manage Your Saved Searches page. 

-Click Return to Search Results to return to the search results.



16- HOW CAN WE CHANGE THE PASSWORD?

To change your password:

1.Log on to PPM Center.

2.From the menu bar, select Open > Administration > Edit My Profile.

Change your password in the Change Password section.

3.In the Change Password section, complete the fields.

4.Click Done.

The new password is accepted.



17- HOW TO HANDLE FEATURE TOGGLES?

Using Feature Toggles to Turn on/off Features

Feature toggles allow you to enable or disable a PPM feature, and its sub-features, if any. 

It is accessible from Administration Console > Administration Task > Feature Toggles.

You can use feature toggles to turn on/off features introduced in 9.53 and later.

With feature toggles, you can:

-Turn features on and off without the need to restart PPM server to make the changes take effect.

-Track the usage of each feature.

-Have flexibility to try a feature and decide whether you plan to continue using it.

Feature types

-Released

Features that are officially supported and ready to use in your production environment.

Released features do not have labels.

-Beta

Features that may not be fully stable or field-tested enough but can work correctly in most scenarios.

You can turn on beta features in your production environment. However, if system stability is more crucial than anything else, we recommend you try beta features only in your 

testing environment.



-Evergreen Candidate

PPM by default turns on features of this type and plans to remove the option to turn off the features. 

We recommend that you train your users about how to use these features before they have to use them.

Configure which types of features are shown

Released features are always shown. By default, beta features are also shown.

You can use the parameter "SHOW_BETA_FEATURES" to show/hide beta features.

Note:  If you already turned on a beta feature, and then set to hide beta features, the feature is still shown in the Feature Toggles page. Only the disabled beta features are no 

longer shown.

How to turn on/off a feature

We recommend that you turn on beta features only in your testing environments, and that you do not turn on under-development features.

To turn on/off a feature, click the feature toggle.

If a feature cannot be turned off once turned on, the toggle has a "forbidden" tooltip.



18- HOW DOES PPM CACHE WORK?

PPM 9.60 Cache architecture helps PPM Administrators to correctly tune PPM Caches  in order to achieve optimal system performance.

There are two type of caches in PPM that can be tuned by PPM Administrators:

-Legacy cache (table components, request type search fields, list validation values, and so on) It is configured in the <PPM_HOME>/conf/tune.conf directory. 

Setting the parameters in server.conf works too, and some of the parameters can be edited from the Administration Console. 

You can view its cache statistics in the Server Cache Status report in Server Tools of PPM Workbench.

-New cache (requests, request types, modules, portlets, workflows, and so on)

It is configured in the <PPM_HOME>/conf/cache.conf directory. 

You can view its cache statistics in the CacheManager Statistics report in Server Tools of PPM Workbench. 

Note: There is a third type of caches in PPM (the Hibernate second level cache). 

However, this is an internal cache that cannot be configured or tuned. 

Its configuration is defined in the <SERVER_HOME>\deploy\itg.war\WEB-INF\conf\ehcache.xml directory 

and it should not be tampered with.



The new cache has the following advantages over the legacy cache:

-All cache objects are stored using Java SoftReference. As a result, if the JVM runs out of heap memory, objects in the cache will be automatically 

garbage collected to free up memory. 

This makes it possible to store large amounts of data in the cache without risking out-of-memory issues under heavy system load.

-There are more cache configuration parameters (at least until PPM 9.31, in which new cache configuration has been simplified).

-It is possible to flush a single object in the new cache by using the ksc_flush_cache special command 

(which only works with new cache), whereas only full cache flush is possible when using kRunCacheManager.sh

(which works with both legacy and new cache).

-The new cache provides configurable staleness checks, whereas such checks are hard coded in the legacy cache.

-More data is included in the cache report (number of staleness checks, average load time, and number of flushes of different types).



19- HOW CAN WE IMPROVE THE PERFORMANCE OF 

SEARCHING REQUESTS?

There is a command "kSingleLanOptimize.sh", this script is used to strip unnecessary logic off the system so as to improve query performance.

You can run this script if you:

-Only use English language and do not deploy any language pack in your environment.

-Want to improve the performance of searching requests by request types.

How to use it.

To deploy the single language optimizer, run the sh ./kSingleLanOptimize.sh -deploy script in the <PPM_Home>/bin directory.

How to revert it.

If you want to use multiple languages in your environment, undeploy the single language optimizer. 

Run the sh ./kSingleLanOptimize.sh -undeploy script in the <PPM_Home>/bin directory.



20- WHAT IS THE FILE SYSTEM'S DIRECTORY STRUCTURE?

The installation process creates the below directory structure.

<PPM_Home>/pdf   

The pdf subdirectory contains all PPM offline Help Center files.

-The <PPM_Home>/pdf/manual subdirectory includes all the html files of the Help Center.

-The <PPM_Home>/pdf/PDFs subdirectory includes the documentation in PDF format.

<PPM_Home>/integration

The integration subdirectory contains information or examples for various common integrations between the PPM Server and external systems. 

<PPM_Home>/logs

The server directory structure has two log directories. 

The <PPM_Home>/logs directory contains the reports subdirectory, which contains a log file for each Server report that is run, and directories named PKG_number and REQ_number. 

reset the server debug level to Maximum debugging information (select Edit > Debug Settings).

<PPM_Home>/reports

The reports subdirectory contains the HTML files for all reports that PPM clients have run.



<PPM_Home>/server

The <PPM_Home>/server directory contains the deployed PPM Server. 

Typically, administrators are not required to make any changes in this directory. 

Server configurations are handled through the provided admin scripts in the <PPM_Home>/bin directory.

<PPM_Home>/sql

The sql subdirectory contains source code for the built-in PPM reports and core PL/SQL packages. 

This is provided for convenience and for customization needs.

<PPM_Home>/transfers

The transfers subdirectory serves as temporary storage for files transferred between the server and remote computers. 

<PPM_Home>/utilities

The utilities subdirectory contains scripts for granting the SYS-level privileges to the PPM database schema, 

and for creating the PPM users required for installing or upgrading PPM. 

It also contains diagnostic tools for troubleshooting PPM installation, and the Watchdog tool.



21- WHAT IS THE BENEFIT OF SERVICES ISOLATION ?

PPM has many asynchronous background services that process data "behind the scenes" while the application is running. 

Depending on data characteristics of your PPM deployment, the overhead of these services in terms of CPU 

and memory demand are difficult to estimate. 

To reduce the impact of services on user response times, we strongly recommend that you isolate the services on a separate JVM 

within the PPM server cluster.

Services isolation does not require isolation of services onto separate physical servers. 

A node that you dedicate to services can reside on the same machine that hosts nodes handling user traffic. 

Even in a shared host model, there is benefit if higher performance-risk services, 

which tend to be CPU-bound on the application tier, have a separate node.

PPM server clustering does not differentiate between primary or backup nodes in terms of configuration. 

The first node to start up attempts to be the "service primary". 



If a node that is considered to be a "backup" starts first, then it is the primary. The objective is to earmark a subset of nodes in the server cluster as services-capable. 

All of the nodes are peers, and "ownership" of services is based simply on startup order.

Note:  if a node that is running services fails, one of the other nodes enabled to run services assumes the role of primary. 

If the node that failed is restarted, services will not automatically "failback" to that node. 

To return services ownership to the node that failed and is restarted, you must stop, and then restart the node that took over services execution from the original services node.

We recommend that you devote at least one PPM node to process PPM background services.

Dedicating one PPM node to your services enables you to:

-Minimize the effect that running PPM services has on users

-Better monitor the performance of the services

The more you monitor and understand how your services affect performance, the better you can tune them.



22- WHAT IS THE WATCHDOG TOOL FOR ?

Watchdog is a stand-alone tool that issues a command to generate a thread dump 

whenever memory exceeds the configured threshold after a full garbage collection (GC). 

This tool requires that the Java garbage collection log be turned on at startup.

Watchdog monitors the memory space through the GC log that the PPM Server generates. 

If the memory used after garbage collection is greater than a set threshold value, the Watchdog issues a command to generate a thread dump, 

and the thread dump is captured in the server log. 

You can configure the Watchdog tool to send out email notifications about this event.

The Watchdog tool does not affect the PPM functionality. 

It is platform-dependent because it uses different mechanisms to generate thread dumps on Windows than on other, UNIX-like platforms.

Note:  Watchdog is not currently supported on AIX systems.



The memory used after a full GC is compared with the threshold. 

The Watchdog tool is interested in the following record in the GC log:

-With the JVM -server option:7.138: [Full GC [PSYoungGen: 3016K->0K(229376K)] [PSOldGen: 0K->2956K(524288K)] 3016K->2956K(753664K) 

[PSPermGen: 9983K->9983K(20480K)], 0.1605436 secs]

-Without the -server option:147.032: [Full GC 147.032: [Tenured: 30756K->34733K(227584K), 0.2966210 secs] 50507K->34733K(253184K), [Perm : 

33487K->33487K(131072K)], 0.2967583 secs]

In the second example (without the -server option), 

the Watchdog reads the record and parses out the memory used before GC as 50507K, 

and memory used after GC as 34733K. The Watchdog then compares the memory used after GC, 

34733K in this case, with the set threshold. 

If the threshold is set to 30, then the record triggers a thread dump. 

If the threshold is set to 35, it does not.



When the memory first exceeds threshold, PPM is considered to be entering a critical condition. 

A thread dump is triggered and a notification is sent.

After the next full GC, if the memory still exceeds the threshold (PPM remains in critical condition). 

No dump is generated as long as the memory is still higher after entering critical condition.

When the memory used falls below the threshold in subsequent GCs, PPM is considered to be exiting a critical condition. 

In this case, no thread dump is generated. 

You can configure the Watchdog tool to send out email notifications about this event.

If, after exiting a critical state, the memory used again exceeds the set threshold, a new critical condition starts. A thread dump is triggered and 

a notification is sent (if set up) every time PPM enters the critical condition.

Tip:  to collect thread dumps when a threshold value is not desired, you can, 

-Use the Watchdog Tool and set memory_threshold to 0. 

Or,

-(Recommended) Use Stack Trace tool jstack to create all thread dumps on all operating systems. 

For example, jstack pid >a.logThe jstack tool is present in the <JDK_HOME>/bin directory.



Generating the GC Log

The Watchdog utility requires that a Java GC log file be present. To enable verbose GC logging when starting PPM:

1.Navigate to the <PPM_Home>/bin directory and open the kStart.sh file in a text editor.

2.Locate the following SYSTEM_PROPS lines in the script:

SYSTEM_PROPS="$SYSTEM_PROPS -Djava.io.tmpdir=$KNTA_HOME/server/$SERVER_NAME/tmp"SYSTEM_PROPS="$SYSTEM_PROPS -

Djava.security.auth.login.config=$KNTA_HOME/server/$SERVER_NAME/deploy/admin-jmx.war/conf/auth.conf"

3.Add the following line to generate the GC metric output file:

SYSTEM_PROPS="$SYSTEM_PROPS -Xloggc:gclog_"$SERVER_NAME"_`date +%Y%m%d_%H%M`.gc -XX:+PrintGCTimeStamps - XX:+PrintGCDetails"

4.Stop, and then start the PPM Server in debug mode by running:sh ./kStart.sh -debug

The <PPM_Home> directory now contains a file with garbage collection metrics, 

and the <PPM_Home>/bin directory contains the PPM Server log.

Note: On Windows systems, you may need to start the PPM Server using kStart.sh. 

If you start the PPM Server in service mode, the Watchdog utility may not work.



To use the Watchdog tool:

1.Make sure that the <PPM_Home> directory contains the GC log file.

2.Navigate to <PPM_Home>/utilities/watchdog/conf directory, and open the watchdog.properties file.

3.Enter the values for the parameters listed in the following table.

4.Find out the Java process ID of the PPM Server you want to monitor, and then run the following:

kWatchdog.sh

This script is used to run the Watchdog tool. 

Watchdog is a stand-alone tool that issues a command to generate a thread dump 

whenever memory exceeds the configured threshold after a full garbage collection (GC). 

This tool requires that the Java garbage collection log be turned on at startup.

Run the command:  sh ./kWatchdog.sh pid



23- HOW TO INSTALL ALM CONTENT BUNDLE?

To install ALM content bundle follow the below steps.

1.Obtain the ALM content bundle.

2.Log on to the PPM Server.

3.Confirm that the system requirements have been met. 

4.Save the ALM content bundle installation file (ppm-950-ALM.jar) to the <PPM_Home> directory. 

<PPM_Home> represents the path where the PPM instance is installed. 

Note: You do not need to unpack the installation file. 

The installation process automatically unpacks it.



Perform Backup and Restart the PPM Server in Restricted Mode

(the steps in this section are recommended but not required)

1.Back up the database and file system for the PPM Server.

2.Stop the PPM Server and restart it in restricted mode, as follows:

a.Stop the PPM Server.

b.Run the following script: sh ./setServerMode.sh RESTRICTED

c.Start the PPM Server.

Run the Installation Script

1.Navigate to the <PPM_Home>/bin directory.

2.Run the following script:     sh ./kDeploy.sh -i ALM

3.As kDeploy.sh runs, respond to its prompts.

When the installation completes successfully, 

the following message is displayed:     Deployment ALM has been successfully installed.



24- ARE THERE KNOWN ISSUES IN PPM 9.55 INTEGRATIONS ?

The following are listed the know issues in PPM 9.55 integrations.

#1: If creating a PPM request automatically creates an entity in ALM, and if the ALM field Detected By is mapped to a PPM user field, with the ALM field controlling the data sync between them, 

PPM uses the ALM username and password specified in the integration configuration page as the default value for the Detected By field when creating the ALM entity. 

This logic works fine if ALM runs in non-SSO mode. 

However, if ALM runs in SSO mode, the logic no longer works because ALM uses API key and API key secret instead of username and password to find the matching user in ALM.

Workaround: Avoid using the ALM username and password to sync the Detected By field. Use the value of the mapped PPM user field instead. 

Change the sync direction between Detected By and the PPM user field to "Bi-directional" and makes sure the user specified in the PPM user field is mapped to an existing ALM user.

#2: PPM does not generate even logs if the sync between a PPM request and its mapped ALM Octane entity fails.

#3: If a PPM request is created and this triggers creating a mapped entity in ALM Octane, 

copying the PPM request also copies the ALM Octane entity ID information.



#4: When a project is integrated with MSP under the MPP file mode, you cannot see if the upload MPP file and download MPP file icons 

in the Work Plan portlet of the project overview page are disabled or enabled. They are displayed the same in both statuses.

#5: When a PPM request triggers creating an ALM Octane entity, updating the entity name to something like <script>xxx</script> 

would save the <script> value in the PPM request. Such format of content should not be saved in PPM requests.

#6: If a project is integrated with MSP under the MPP file integration mode, uploading an MPP file for the first time is successful, 

but an internal error occurs when uploading a second MPP file. This happens when the parameter USE_MPP_FILE_HIGH_PERF_WP_SYNC is enabled.

Workaround: Set USE_MPP_FILE_HIGH_PERF_WP_SYNC to false.

#7: If the ALM Octane client ID or secret includes special characters <, >, or &, you cannot create an ALM Octane agile instance successfully.



25- HOW TO CUSTOMIZE PPM WORKBENCH TITLE BAR?

In order to customize PPM Workbench Title Bar to users

you need to set the server.conf parameter CUSTOM_SERVER_INFO. 

This parameter enables customization of the PPM Workbench title bar.

For example:

com.kintana.core.server.CUSTOM_SERVER_INFO=Welcome to PPM workbench

In clustered environment, you can customize the PPM Workbench title bar 

of each node by setting the server.conf parameter CUSTOM_SERVER_INFO value on each node; 

if no value is set, the nodes will follow the master node's setting.

For information about how to edit the server.conf file, 

see the Installation and Administration Guide.



26- WHAT ARE APM ENTITIES?

In Application Portfolio Management (APM), entities are the means by which actions and processes are initiated and tracked. They are the building blocks of an application portfolio. 

Entities contain all of the information necessary to take a series of actions and move through a workflow. 

They are used to identify objects and designate the relationships and interactions within an organization. 

An APM entity is a type of Project and Portfolio Management Center (PPM Center) request.

As a user, you can help build an application portfolio by creating application entities for your organization. Application entities are for software applications or programs 

that implement a business process or function in your organization. An application can be made up of one or more distinct services.

Application Entity Detail Page

When you create or view an application entity, you use the entity's detail page. 

The detail page contains all of the information about the entity. It is where decisions and actions that pertain to the entity are executed.

Application entity detail page with several expanded sections shows an application entity detail page and its main sections with the Identity and Contacts sections expanded.

The entity detail page for an application entity is similar to the detail page for a request. 



Creating Application Entities

The first step in building your application portfolio is to create the entities that make up the portfolio.

While it is possible to build your portfolio from just applications, designating relationships with other entities, servers, and organization units when your user configuration allows it provides 

the ability to conduct a more detailed and quantifiable analysis for the application.

Note: Before you create an application entity, you should understand the relationships that the APM analyst has configured for your organization 

(for example, the business objectives and processes).

You create a new entity from one of the following locations:

-The Open > Application Portfolio > Create Entities option on the menu bar

-The Create > Application option on the menu bar (a shortcut for creating an application entity)

-The References section on an entity detail page

-The Make a Copy button on an entity detail page

The APM analyst can create entities by importing them into APM using the PPM Data Migrator

for Microsoft Excel (Data Migrator). 

When you create an entity, it is automatically assigned a unique number and tracked from start to finish. 

This ensures completion and accountability for all steps within the entity's workflow.



Application Portfolio Management (APM) enables your organization to assess and 

prioritize its current application portfolio and determine which applications need to be modernized. 

Organizations use APM as the first step towards application transformation as they:

-Document the size of their application portfolio and the applications that support their business processes.

-Compare and analyze application information such as health, effectiveness, ownership, 

cost of ownership, business value, and risk.

-Identify improvement opportunities and modernize their application portfolio 

by making strategic decisions about the future of each application in the portfolio, 

including whether the applications should be kept, changed, or retired.

APM is a module of Project and Portfolio Management Center (PPM Center). 

It adds functionality to the standard PPM Center interface.



APM Components

The standard user interface for APM is a collection of specialized Web pages in PPM Center with components that offer you a customized view into APM. 

You use these Web pages to perform the tasks that you are responsible for as a user—tasks such as creating and searching for entities and 

responding to surveys or requests for information about applications. You use the PPM Dashboard, another Web page, to view portlets.

Note: If you have a pop-up blocker or download blocker active on your Web browser, you might have difficulties using the Web pages.

APM components available for users include the following:

1-APM–specific pages that you access from the following PPM Center menu bar options:

-Open > Application Portfolio. 

Used to access the options you select to create application entities, 

search for and open entities, access saved searches, and review data from grouped entities.

-Create > Application. A shortcut to the page you use to create application entities.

-Search > Entities. A shortcut to the page you use to search for and open APM entities of all types.

2-PPM Dashboard pages and portlets that contain information of value to a user.

3-The Browse Entities page—the preliminary page in the Request Browser from which you can group entities for data analysis. 

You access the Browse Entities page from Open > Application Portfolio > Analyze > Groups > Group Entities. 



28- HOW CAN WE MANAGE THE DASHBOARD AND PORTLETS IN 

APM?

You can use the PPM Dashboard, PPM Dashboard pages, and portlets to create views that allow you to easily track the applications that you own, 

surveys to which you have been asked to respond, and applications for which you have been asked to provide information. 

Dashboard

The PPM Dashboard, located on the menu bar, provides the core of the standard user interface. 

It is a real-time Web page view into your application portfolio. By viewing pages on the PPM Dashboard, you can obtain accurate,

up-to-the-minute status information about your applications and deliverables.

PPM Dashboard pages, accessed from the PPM Dashboard, organize application data. 

You can choose to devote one PPM Dashboard page to application data and designate another for information about surveys you have been asked to complete. 

How you organize your data is entirely up to you.

Two types of PPM Dashboard pages are available for users in APM:

-Shared PPM Dashboard pages. 

Shared PPM Dashboard pages are preconfigured PPM Dashboard pages provided by APM or configured by the APM administrator. 

They are made available to one or many users. You cannot edit a shared PPM Dashboard page or the portlets it contains.



APM supplies two shared PPM Dashboard pages for users: Front Page and Applications.

These pages contain portlets that provide the type of information that is typically used by an analyst.

Tip: Shared PPM Dashboard pages are also known as HP-supplied PPM Dashboard pages.

-Private PPM Dashboard pages. 

You create and configure your private PPM Dashboard pages.

You can add configurable portlets to a private page, move the pages up or down in the list of pages, and delete them. 

You can also configure the information displayed in shared portlets that you add to private pages.

The default PPM Dashboard page is the first PPM Dashboard page you see when you log on to APM. For users who have personalized their PPM Dashboard, 

it is the first private page on the list; for new users, it is the first shared page on the list.



Portlets

Portlets are displayed on PPM Dashboard pages. 

They display real-time information relevant to your role as an APM user.

Two types of portlets are available in APM: shared and configurable.

-Shared portlets. 

Shared portlets are preconfigured portlets provided by APM or configured by the APM analyst or administrator. 

They are predefined versions of the configurable portlets. Shared portlets are displayed on the shared PPM Dashboard pages. 

You can edit shared portlets only if you first add them to a private PPM Dashboard page.

The shared portlets for users contain information related to the applications they own, 

workstreams for which they are a resource, applications requiring their input, 

surveys requiring their response, and the applications in the organization's portolio.

Note: Shared portlets are also known as HP-supplied portlets.



-Configurable portlets.

APM provides several configurable portlets that 

you can add to your private PPM Dashboard pages and personalize. 

Configurable portlets are highly customizable—by setting filters, 

you can configure the data that is displayed.

The configurable portlets for users contain information related to the applications they own,

workstreams for which they are a resource, applications requiring their input, 

surveys requiring their response, and the applications in the organization's portolio.



29- WHAT CAN WE DO WITH DEMAND MANAGEMENT MODULE ?

Demand Management is the component of Project and Portfolio Management Center (PPM) that manages requests from creation to implementation. Each request is processed 

using a workflow that is represented graphically in the user interface. 

Demand Management features tools and configurable processes for dealing with these requests. Data is captured by prompting for process-specific information to ensure that 

the required information is collected and validated at the right time in the process.

Demand Management can follow complex business rules by using different approval methods. Email and pager notifications can be generated as the request passes through the 

various workflow steps. 

Prioritization and delegation features allow requests to efficiently advance through the workflows applied to them, routing them to the relevant department, group, or individual.

Relevant topics:

-In Demand Management, requests are the means by which actions and processes are initiated and driven. Requests contain all of the information required to take a series of 

actions that move requests through a workflow. Viewing Requests presents information about the major features of Demand Management requests.

-You can use Demand Management to submit several different types of requests, from simple software defect requests to project scope change requests. Creating Requests 

provides details on how to create these.

-After you create a request, you process and manage it. Processing and Managing Requests provides instructions on how to open and update requests, and how to use reports 

and portlets to manage them.

-Micro Focus customers who have both Demand Management and Project Management can integrate Demand Management's request tracking capability with Project 

Management's deliverable date and actuals tracking capabilities. Integrating Requests and Projects presents information on how to integrate and work with tasks and requests.

-Demand Management supplies a preconfigured page that demand managers can use to monitor and manage requests. Demand Manager Page provides descriptions of this 

page and the portlets it displays.



30- WHAT CAN WE DO WITH FINANCIAL MANAGEMENT MODULE 

?
PPM provides a set of functionality collectively referred to as Financial Management. 

1-Cost rules:  set up and use cost rules to provide detailed estimates of labor costs.

-Cost rates can be based on a number of different cost factors.

-Cost factors can be organized by order of precedence.

2-Currencies:  use and display multiple currencies in one installation of PPM.

-Currency display can be user-based or entity-based.

-Currency values are tracked against each other using financial exchange rates.

3-Regions:  create regions to associate them with entities.

4-Financial summaries:  use financial summaries to track forecast and actual costs and benefits and approved budgets for lifecycle entities and programs over a range of years.

-Forecast labor costs in the financial summary can be rolled up (automatically calculated) from the staffing profile.

-Actual labor costs in the financial summary can be rolled up from time logged on time sheets if Time Management is used, and also from project work plans if Project 

Management is used.

-Actual non-labor costs in the financial summary for a project can be rolled up from the project work plan if Project Management is used.

-A program roll-up financial summary is the summation of the financial summaries of the projects in the program if Program Management is used.

5-Financial data tables:   configure, create, and use financial data tables to track forecast and actual costs and benefits for any type of request, including but not limited to 

lifecycle entities. Financial data tables are used to track forecast and actual costs and benefits for such purposes as tracking indirect costs and/or benefits.

6- Cost capitalization:  capitalize software development costs in accordance with SOP 98-1 guidelines.



31- WHAT CAN WE DO WITH RESOURCE MANAGEMENT MODULE ?

1-Resource Management, which is part of Project and Portfolio Management Center (PPM), provides an array of tools for managing personnel related to IT initiatives.

2-Role and skill modeling capabilities unlock the potential of resources, while regional calendars make it easier to accurately determine available working hours as well as 

holidays and vacations. See Setting Up Resource Management for more information on the setup work that should be completed before using Resource Management.

3-Organizational modeling capabilities keep track of where resources are located and who they report to. See Modeling Your Organization for more information on modeling your 

organization at the individual and group level using Resource Management.

4-As resources are assigned to tasks and requests, executives and managers have full visibility into the capacity of their teams and the load placed on them, in terms of both 

current execution and capacity planning for the future.

-To support future demand and project planning, resource forecasting capability is achieved with staffing profiles and resource pools. High-level visualizations help program and 

resource managers with assessing project feasibility and timing, and with making advance staffing decisions and allocations. See Using Resource Management for Capacity 

Planning for more information on using resource pools and staffing profiles to model and plan for resource allocations.

-To support current demand and project planning, Resource Management delivers a set of visualizations and related tools that managers and individual resources can use to 

communicate each others' needs and capabilities. These include work calendars, standard planning fields on tasks and requests, and resource load and capacity histograms. See 

Using Resource Management for Work Plan and Request Execution for more detailed information on using Resource Management visualizations to assess current resource usage 

and optimize operational capacity.



32- WHAT IS THE EXTENSION FOR ORACLE E-BUSINESS SUITE ?

Deployment Management Extension for Oracle E-Business Suite usually referred to hereafter as “the Extension” helps organizations to automate deployment management 

and manage a wide range of business processes in the Oracle E-Business Suite (Oracle Apps) environment.

The Extension enhances the functionality of the Deployment Management application in PPM by providing predefined entities that are unique to Oracle E-Business Suite environments. 

These entities include specialized workflows, request types, work plan templates, object types, special commands, tokens, and report types (beyond the reports of Oracle E-Business Suite itself).

The Extension lowers costs and shortens implementation time for Oracle E-Business Suite by providing automated processes built upon known best practices for the following:

-Deployment management, including project and ongoing operational requests

-Project management, including implementation and upgrade of Oracle E-Business Suite and gap analysis

-Deployment management, including, for example, managing the following:

...Requests for enhancements

...Requests for new report types

...Requests for conversion and importation of data from third-party applications into Oracle®

...Deployment of changes

-Instance management, including instance cloning

-Patch management, including impact analysis and patch deployment



The installation process for the Extension copies various entities into the PPM Center database, including the following:

-Menus in the standard interface and preconfigured Dashboard pages that are specifically designed for Oracle E-Business Suite

-Oracle Applications or Ora Apps tabs (for Oracle E-Business Suite) in the Environment, Object Type, and User windows

-A work plan template

-Object types

-Report types

-Request types

-Workflows

-Security groups

-Validations

After PPM has been installed at or upgraded to version 9.40, you can install the Extension or upgrade it to version 9.40 on the same system.



33- HOW TO INSTALL THE EXTENSION (ORACLE E-BUSINESS SUITE) ?

To run the installation script to install the Extension:

1.Be sure the PPM Server is running in restricted mode.

2.On the PPM Server, navigate to the bin subdirectory of the <PPM_Home> directory.

3.Run the following script:  sh ./kDeploy.sh -i OracleApps

4.Follow the script’s on-screen prompts to complete the installation. 

Prompts can include the database password for the schema and the logon name and password for the server.

Files are installed in various subdirectories under <PPM_Home>. 

Data is also placed in the database. When the installation script is complete, the following message appears: 

Deployment OracleApps has been successfully installed.

5.Use a Web browser to check the installation summary report, which is located at: 

<PPM_Home>/logs/deploy/940/oracleApps/<Log_x>/installLog.html where <Log_x> is initially a random number generated by kDeploy.sh during installation. 

The number increments by one each time the installation script is run, so the installation summary report for the most recent run is in the directory with the highest number. 

The installation summary report lists all the entities that are installed as part of the Extension installation process. 

Each entity that was installed correctly is marked as Complete. 

If there is an error for a particular entity, the report contains a direct link to another log file (HTML page) with additional information.



Verify the Installation. We strongly recommend that you verify correct installation. 

To verify that Extension version 9.50 for Oracle E-Business Suite is listed among the installed Extensions, 

navigate to the <PPM_Home>/bin directory and run the following script:   

sh ./kDeploy.sh -l

where the last character in the command is the lowercase letter “l.”

The name OracleApps should appear in the list of installed Extensions.

For example, if both Deployment Management Extension for Oracle E-Business Suite 

and Deployment Management Extension for Oracle Technology are now installed at version 9.50, 

the following table entries are displayed:

Deployment.....Version........Deployed............Description

oracleApps..... 950........<date and time>.....Oracle Apps Extension

OracleTech..... 950........<date and time>.....OracleTech Extension



34- HOW TO MANAGING ISSUES IN ORACLE E-BUSINESS SUITE ?

During an Oracle E-Business Suite implementation or upgrade, there is a constant influx of new problems, questions and requests.

Each issue must be quickly addressed and resolved in order to prevent a growing backlog that can jeopardize the success of the project. 

Often these issues are captured in a variety of places—design documents, testing scripts, email discussions among team members, and help desks. 

Some problems, questions, and requests simply fall through the cracks and become visible only when the issue escalates.

The Extension provides the necessary tools for effective issue management. 

The Extension systematizes the process of issue analysis and resolution, so that the appropriate detailed data is gathered at the right time. 

The Extension recognizes and intelligently routes issues based on whether they are internal, external, or vendor (that is, an Oracle bug).

Through automation and notifications, the right people work on the right issues at the right time. 

Then, when resolution means a change to the system, the process integrates with other Extension functionality 

so that development and deployment maintain the same level of control and visibility.

Throughout the life of an issue, you can monitor its status and progress through the PPM interface. 

Reports help assess both individual issues and the aggregate status of groups of issues. Once the implementation or upgrade is complete, 

you can use the issue management processes on an ongoing basis for maintenance.

This section provides conceptual and procedural information about issue management and the entities (request types, workflows, and report types) relating to issue 

management provided in the Extension.



Capturing and Tracking Issues

The OraApps Application Issue request type is used to capture and track the issues at an Oracle E-Business Suite implementation site. 

This request type provides a means for specifying information needed to resolve issues, and it works in conjunction with the OraApps Application Issue workflow.

Someone creates a request in order to resolve a specific problem. The request originator is prompted for the information needed to successfully identify and analyze the issue. 

This information focuses on the Oracle environment in addition to project and business information. After providing all necessary information, the originator submits the request.

The following items are examples of the kind of information the request type uses:

-Oracle environment information

-Application in which the problem occurred

-Form being used

-Operating system being used

-Project and business information

-Business area affected

-Perceived business benefit for resolving the issue

-Source of the issue

-Estimated technical impact on the organization

-Attachments (for example, relevant documents and image files)

When all the relevant information for an issue has been specified for the OraApps Application Issue request type, 

the information can be analyzed and processed through to resolution.



35- PPM PROGRAM MANAGEMENT.

Program Management is an PPM product that provides a single location from which to initiate, 

operate, and manage your organization's portfolio of programs and lifecycle entities.

Note: the term "lifecycle entity" is used to mean a proposal, a project, or an asset, and "lifecycle entities" are any combination of proposals, projects, and assets.

Each of these types of lifecycle entities can be created from scratch, but typically a proposal automatically becomes a project upon approval of the proposal 

and the project automatically becomes an asset upon completion of the project. This progression is referred to as a lifecycle and proposals, projects, 

and assets are the entities that make up this lifecycle.

You can use HP Program Management to:

- Align IT projects with business objectives

- Eliminate duplicate and low-priority efforts

- Improve operational efficiency

- Ensure delivery on time and within budget

To help you meet these business requirements, Program Management provides a full program lifecycle solution. 

It enforces the systematic capture of all relevant functional specifications and priorities. Business user approvals based on project scope, approved budget, 

and other business rules are built in. The program provides a single location from which to view and control relevant proposals,

projects, assets, and requests.



You might organize lifecycle entities into a program for many different reasons. You can create a program to manage a group of projects that 

were all designed to meet a single business objective. For example, you could design a program around a single deliverable 

(a project that requires infrastructure, coordinated development, and other deliverables), or around work performed for a given client.

How you group lifecycle entities into programs typically reflects how your organization controls them internally. 

Each program has one or more owners (program managers) who are responsible for the overall coordination of the lifecycle entities, 

resolution of issues that cannot be resolved through individual projects, overall budget management, and so on.

In some cases, a program is designed to provide visibility into a set of lifecycle entities that share something in common, but do not share a business goal. 

For example, you can create a program that provides a department with a consolidated picture of all the projects it "owns," 

even though the individual projects are part of otherwise unrelated programs.

You can use Program Management to assess the various risks, issues, and changes in scope that arise during the life of a program, and make the changes necessary to manage these events.

Program Management can help you:

- Oversee related IT projects

- Coordinate inter-project deliverables and milestones

- Manage scope change

- Identify and mitigate risks

You access the Program Management interface through the PPM Dashboard and menu bar. 

The PPM Dashboard displays portlets that you can customize to fit your specific business requirements.



36- PPM BUSINESS OBJECTIVES
Business objectives provide a way for you to capture business goals as discrete entities that you can then prioritize and tie to other PPM Center entities, including programs. 

For example, XYZ Corporation creates the business objective "Reduce order to delivery time," assigns it a priority, and associates it with a program created to upgrade the customer service system.

You can create business objectives in either Portfolio Management or Program Management. You can associate a program with existing objectives. 

If you want to associate a program with a business objective that does not yet exist, you can either create the business objective before you create the program, or create it later and make the association after you 

create the program. 

This section provides the steps you use to create business objectives from Program Management.

To create a business objective:

1. Log on to PPM Center.

2. From the menu bar, select Create > Administrative > Business Objective.

The Create New Business Objective page opens.

3. Provide information about the business objective that you want to add.

4. Click Create. The Manage Business Objectives page now lists the new objective.

Note: If your PPM Center instance supports multiple languages, 

any business objective you create is defined in the language you selected at logon (your session language). 

After the business objective is created, it can be modified only in its definition language. 

A program is a set of related lifecycle entities that are grouped together, usually to coordinate efforts toward achieving a business goal. 

With HP Program Management, you can create programs that provide a high-level perspective on proposals, projects, and assets in your organization.



Modifying Business Objectives

Because business objectives can change over time, you may want to update them by adding details or removing obsolete information.

Note: If your PPM Center instance supports multiple languages and the business objective is defined in a language other than your session language, you cannot modify the business objective.

Submitting Issues, Risks and Project Scope Changes

During the life of a program, concerns surface that must be addressed. PPM Center provides a framework to identify and resolve such concerns in the form of requests. 

You can submit (create), track, reject, complete, and report on requests. The following requests can affect programs:

- Program Issues. To manage problems having to do with running the program itself, you can submit program issues. For example, submit a program issue if you have a problem assigning a manager or

support staff to a program, or if a change in corporate direction requires that you reassess program goals. 

If an issue logged against a project linked to a program cannot be resolved by the project manager, then it needs to be visible at the program level. Program issues often involve coordination among multiple 

projects.

- Project Issues. Project issues introduce a framework for all project-related issues to identify and resolve. Issues can span multiple request types to provide a more detailed view of the resolution process.

For example, although bugs and enhancements are both issues and may share common fields for tracking purposes, each request type is processed along its own assigned workflow.

- Program Risks. To manage threats having to do with running the program itself, you can submit program risks. You can configure program health indicators to alert users to varying levels of risk. Risks displayed 

on the Program Overview page are for both program risks and project risks from projects included in the program.

- Project Risks. Risks supply a way to log and resolve threats to a project. The process of gathering information about possible risks, including impacts and probability of occurrence, is streamlined.

You can configure program health indicators to alert users to varying levels of risk.

For example, the program manager at XYZ Corporation configures the customer service upgradeprogram to show a red indicator if more than two risks that have an impact level of 1 and probability factor of High 

are created.

- Project Scope Changes. Scope changes provide a way to ensure that the scope of a program and its individual projects stay manageable. Submitted scope change requests can be assessed before they are 

rejected or incorporated into program or project scope. To control program and project scope, ensure that possible changes are clearly identified, aligned, and processed.



37- PPM PROGRAM MANAGER PAGE.
Program Management comes with a preconfigured Program Manager page. 

The Program Manager page can display one or multiple programs, depending on how you configure the portlets on the page.

You can also configure multiple Program Manager pages to view multiple programs. Program Manager page" on the next page shows the Program 

Manager page.

..see "program manager page.png"

Adding the Program Manager Page to the PPM Dashboard

To add the preconfigured Program Manager page to your PPM Dashboard:

1. Log on to PPM Center.

2. From the menu bar, select Dashboard > Personalize Dashboard. The Personalize Dashboard page opens.

3. Click Private pages in the area to the right of the menu bar.

4. Click the Add New icon.

5. Select Add Preconfigured Pages. A list of available preconfigured PPM Dashboard pages is displayed.

6. Select the Program Manager page and click OK. The page is added to your PPM Dashboard.

7. Customize the Program Manager page and portlets as required. The changes to your PPM Dashboard are automatically saved.



38- USING STAFFING PROFILES WITH LIFECYCLE ENTITIES
Staffing profiles allow project managers to plan and track the anticipated demand for resources, organized by role. Each line in a staffing profile tracks a role and optionally a resource who can fulfill that role.

Staffing profiles can be linked in a one-to-one manner with lifecycle entities—proposals, projects, and assets. When a proposal is approved and becomes a project, if a staffing profile is attached to the proposal, 

the staffing profile is copied and attached to the project. When a project is completed and becomes an asset, the staffing profile of the project is not copied to or shared with the asset. 

If the asset requires a staffing profile, create a new staffing profile for the asset.

Creating Staffing Profiles and Linking Them to Lifecycle Entities

You can link an existing staffing profile to a lifecycle entity, or create a new staffing profile that is linked to the lifecycle entity, as follows:

-In a proposal or an asset, in the Staffing Profile field in the Business Case Details section, select an existing staffing profile or click Create.

-In a project, to create a staffing profile, click the Create a Staffing Profile button on the Project Summary tab of the Project Overview page. 

To link an existing staffing profile to a project, from the menu bar select Search > Staffing Profiles, and then search for, select, and open the desired staffing profile. 

In the Staffing Profile window, click Change Header. In the Change Staffing Profile Header window, select Project in the drop-down list after the text. 

This is a and select a project so that the screen text and fields read: This is a Project Staffing profile for < selected project > 

Calculating Financial Summary Forecast Costs from Staffing Profiles

A lifecycle entity's financial summary can be configured such that its forecast cost for labor is calculated (rolled up) from the lifecycle entity's staffing profile.With this configuration, if an individual resource has a 

cost category specified, 

that cost category is used for the financial summary forecast. If the resource has no cost category specified, the position's category is used.

This configuration is enabled or disabled in the Financial Summary Settings page for proposals and assets, and in the Cost and Effort policy of the Project Settings page for projects.



39- USING BUSINESS OBJECTIVES WITH LIFECYCLE ENTITIES
Business objectives provide a way to track your business goals as discrete entities that can be prioritized and linked to lifecycle entities. The Business Objective field in a lifecycle entity links the lifecycle entity to that business objective. 

You can create, modify, and delete business objectives independent of the lifecycle entities. However, business objectives that have already been linked to lifecycle entities cannot be deleted.

In addition, the Portfolio By Business Obj portlet, which is one of the Portfolio By <Category> portlets, displays bar charts of the budget breakdown by business objective over time. 

Finally, the Budget By Business Objective tab of a scenario comparison is one of several budget visualizations shown for three scenarios over time.

To create and update business objectives, you must have the Edit All Portfolios access grant. 

Creating Business Objectives and Linking Them to Lifecycle Entities

Note: If your PPM Center instance supports multiple languages, any business objective you create is defined in the language you selected at logon (your session language). After the business objective is created, it can be modified only in its definition language. 

To create a business objective:

1. Log on to PPM Center.

2. From the menu bar, select Open > Portfolio Management > Business Objectives > Create Business Objective.The Create New Business Objective page opens.

3. Complete all required fields and any optional fields.

4. Click Create. The business objective is created.You can link a proposal, project, or asset to an existing business objective, as follows:

-In a proposal, in the Business Objective field of the Proposal Details section, select an existing business objective.

-In a project, in the Business Objective field in the PFM Project section on the Project Details tab, select an existing business objective.

-In an asset, in the Business Objective field in the Asset Details section, select an existing business objective.

To update a business objective: 

1.Log on to PPM Center.

2.From the menu bar, select Open > Portfolio Management > Business Objectives > Manage Business Objectives.

The list of existing business objectives is displayed.

3.Click the name of the business objective you want to revise, or click the Delete icon to delete the business objective.

4.Update the business objective as desired and click Done.



40- OVERVIEW OF CREATING AND VIEWING HIERARCHICAL PORTFOLIOS

Note: In this document, the term "lifecycle entity" is used to mean a proposal, a project, or an asset, and "lifecycle entities" are any combination of proposals, projects, and assets.

Each of these types of lifecycle entities can be created from scratch, but typically a proposal automatically becomes a project upon approval of the proposal and the project automatically 

becomes an asset upon completion of the project, 

depending on the configuration of the request types.

Portfolio Management allows you to create and track financial information for portfolios that are structured in a hierarchy. 

A hierarchical portfolio is most useful when it is built from a single point of view, such as the IT organization and the services it provides, or a business unit and its demand for those services. 

You can specify any set of meaningful names for the portfolios throughout the hierarchy, based, for example, on an organizational structure, a set of geographies, or functional or strategic 

needs.

Each hierarchical portfolio can include the following items you specify:

-Other portfolios, which become subportfolios when added to a portfolio. The hierarchy of all portfolios in the PPM instance is displayed on the View Portfolio Hierarchy page. 

The portfolio at the next higher level above a subportfolio in the portfolio hierarchy is known as the subportfolio's parent portfolio, and the subportfolio is sometimes also referred to as a child 

of the parent portfolio.

You must be allowed to edit both the potential parent portfolio and its potential subportfolio to establish the hierarchical relationship of parent portfolio and subportfolio. Similarly, you must be 

allowed to edit both the parent portfolio and 

its subportfolio to remove the subportfolio from the parent portfolio. 

Note: Subportfolios can be nested to any desired level (depth) of subordination.

A portfolio (or subportfolio) can have a maximum of 40 subportfolios at the next lower level.



-Programs, which include collections of lifecycle entities (proposals, projects, and assets). Programs added to a portfolio are also known as the "direct" programs in the portfolio, 

as distinct from the programs in the portfolio's subportfolios.To add a program to or remove it from a portfolio, you must have the security access required to view the program (but you do not need to have an HP Program Management 

license). 

To add a program to a portfolio, in Program Settings the program must be enabled for HP Portfolio Management. 

Note: A portfolio (or subportfolio) can have a maximum of 250 programs.

-Proposals, projects, and assets, which are also known as "direct" proposals, projects, and assets when they are added to the portfolio, as distinct from the proposals, projects, and assets in the portfolio's programs and subportfolios.

To add a proposal, a project, or an asset to, or remove it from, a portfolio, you must be allowed to view the proposal request, view the project, or view the asset request. 

Note: A portfolio (or subportfolio) can have a maximum of 1000 proposals, projects, and assets combined.A portfolio at any level in the hierarchy provides a rollup of forecast and actual costs and benefits and approved budgets on the

collection of subportfolios, 

programs, proposals, projects, and assets that you choose for the portfolio. 

To prevent "double counting" of financial information among portfolios or within one portfolio, every subportfolio, program, proposal, project, or asset can be included in only one portfolio and only once in that portfolio. When you 

search for items to add to a portfolio, the search results automatically exclude particular items as follows:

-A search of subportfolios to add to a portfolio excludes all other subportfolios (that is, all portfolios that already have a parent portfolio).

-A search of programs to add to a portfolio excludes all programs that are already included in any portfolio (directly, or as part of any subportfolio).

The search also excludes all programs that are not enabled for Portfolio Management in their Program Settings.

Note: Multiple programs can include the same lifecycle entity, and where that is the case, HP Program Management ensures that no more than one of those programs is enabled for HP Portfolio Management, that is, 

eligible to be included in a portfolio. If one of those programs is in fact enabled for HP Portfolio Management,only that program, among the programs that include the same lifecycle entity, can be added to a portfolio. 

-A search of proposals, projects, or assets excludes all the ones that are already included in any portfolio (directly, or as part of any portfolio's programs or subportfolios).

Note: Creating, viewing, and modifying portfolios requires the Portfolio Management license, as well as particular access grants and access rights as described in the

Program Management Configuration Guide and "Configuring Access Rights for Hierarchical Portfolios"



41- WORKBENCH APP

Access to the PPM Workbench requires an appropriate version of the Oracle Java plug-in installed. 

Supported versions include:

-Java 8 Update 191 or later update (32-bit and 64-bit) for IE on Windows

-OpenJDK 8 Update 191 or later update (32bit and 64bit) on Windows

The desktop application "Workbench App" is required if you want to access PPM Workbench using OpenJDK.

Install Workbench App

1. Select Open > Administration > Workbench > Open workbench App.

2. In this page, click the download link and save the Workbench bundle to computer.

3. Unzip the downloaded zip file.

4. Double click install.bat to register Workbench.

To open workbench application from the installation folder:

1. Open the workbench folder of the unzipped workbench bundle.

2. Double click Startup.bat.

3. Enter the PPM URL and user credential information. 

To open workbench application from the PPM web page:

1. Select Open > Administration > Workbench > Open workbench App.

2. Accept the browser's prompt to open Workbench smoothly next time.

Note: If SSO is enabled, exclude the Workbench URL from SSO’s protection: 

http://<PPM_Base_URL>/itg/wbservices



42- WORKBENCH RUNNING AS A JAVA APPLET

To configure Workbench to Run as a Java Applet. When PPM is run in the SSO mode, you can only open workbench in Internet Explorer using the PPM menu Open > Administration > Open Workbench.

Enabling SOCKS Proxy (Optional)

Using the SOCKS proxy feature in PPM improves security. With SOCKS proxy enabled, all RMI connections are routed through a central server so that each and every PPM Workbench is not required to contact the application server directly. 

The SOCKS proxy feature also makes it easier to monitor RMI traffic.

To enable the SOCKS proxy feature in PPM:

1.Open the server.conf file in a text editor.

2.Set the following two parameters:

-com.kintana.core.server.SOCKS_PROXY_HOST

-com.kintana.core.server.SOCKS_PROXY_PORT

For the com.kintana.core.server.SOCKS_PROXY_HOST value, provide the hostname of the SOCKS proxy server.

For the com.kintana.core.server.SOCKS_PROXY_PORT value, specify the port on the SOCKS proxy host that accepts proxy connections.

The PPM Server passes the SOCKS proxy configuration forward to the client applet launcher. Users are not required to configure anything.

To specify a different JRE version in the server.conf file, reset the com.kintana.core.server.WORKBENCH_PLUGIN_VERSION parameter.For example: com.kintana.core.server.WORKBENCH_PLUGIN_VERSION=1.7.0_04

Running PPM Workbench with HTTP(S)

Starting from 9.40, PPM Workbench communicates with PPM Server via HTTP(S) by default, the same port that is used in communication between Web browser and PPM Server.If you find PPM Workbench communicates with PPM Server using RMI(S) port, 

you can do the following to enable the communication via HTTP(S):

1.Stop the PPM Server.

2.Set the parameter ENABLE_WORKBENCH_HTTP to true in server.conf file. By default, it is true.

3.Provide a value in the parameter WORKBENCH_SERVICE_URL. This is the address of PPM Server with which PPM Workbench communicates via HTTP(S). 4.Run the kUpdateHtml.sh script.

5.Start the PPM Server.



43- WORKBENCH FROM USERS' PERSPECTIVE.

Starting the PPM Workbench on client machines. It also includes information on how to address JVM-related problems that can arise on client machines. 

Installing and Configuring the Java Plug-In on Client Machines. The server.conf contains one parameter that is associated with the Java plug-in. The JAVA_PLUGIN_XPI_PATH parameter specifies the Web location 

for downloading the cross-platform Java plug-in installer for Firefox browsers. The default setting for this parameter is http://javadl.sun.com/webapps/download/GetFile/1.7.0_11-b21/windows-i586/xpiinstall.exe.

However, if needed, you can go to the following address to find the specific web location for downloading the .xpi file for your Firefox browser:  http://www.oracle.com/technetwork/java/javase/autodownload-140472.html

Setting the Default Web Browser

To run the PPM Workbench interface as an application, users must specify the default browser setting in their user profiles.

To set the default browser setting:

1.From the shortcut bar in the PPM Workbench, select Edit>User Profiles.

2.On the General tab, in the Default Browser field, type the full path of the default Web browser. If access to a URL is required, the PPM Workbench uses the default Web browser.

Starting the PPM Workbench on a Client Machine

On the menu bar, select Open > Administration > Open Workbench to start the PPM Workbench from the PPM standard (HTML) interface.

Troubleshooting Tips

-If a pop-up blocker is installed and enabled on the Web browser, the PPM Workbench cannot open. The user can configure the blocker to enable pop-ups from PPM.

-If the user is stuck on Verifying Installation screen or sees the message "Unable to launch the application", the user probably needs to configure the Java plug-in add-on in your Windows Internet Explorer browser to allow access to PPM Workbench.

To configure Java plug-in add-on, a.In the Internet Explorer, click Tools > Manage Add-ons.

The Manage Add-ons window displays.

b.Locate the Java Plug-in 1.7.0 add-on. The details for the add-on display. If the add-on is disabled, click Enable.

c.Click More Information link in the details section.

d.In the You have approved this add-on to run on the following websites box, type *. e. Click Close twice.

-When open PPM Workbench in 64-bit Internet Explorer by clicking Open > Administration > Open Workbench, you are prompted to install Java plug-in 1.7.0. After installing the Java Plug-in by following the screen instructions, 

you still receive prompt asking you to install Java plug-in 1.7.0.This is because Oracle provides automatic installation kit for 32-bit Java Plug-in 1.7.0 only.

To install the 64-bit Java plug-in 1.7.0, go to Oracle website, manually download and install the 64-bit Java plug-in 1.7.0.



44- LOGGING ON IN YOUR SESSION LANGUAGE

After the multilingual user interface on your PPM instance, users can select their session language from the Language list on the logon page. 

The default session language displayed in the Language field at logon is the locale setting configured for the Web browser. 

If PPM does not support the preferred language set for the browser, the system language becomes the default session language.

To use a language other than the default to interact with PPM, users must select it when they log on to PPM.

The languages available in the Language list depend on the language packs deployed on the system. 

Language packs replace the English language text in the user interface with text in a different language. 

For the session language that a user selects, the system tries to display all text attributes in the user interface in the selected language. 

This includes all static boilerplate text in the interface, as well as custom attributes. However, translations may not exist in the selected language 

for all custom attributes. Attributes that are not translated are displayed in the language in which they were defined.

If a user cannot work with a form in PPM, it is likely that the underlying configurations have not yet been translated into the user's session language. 

For example, if activities have been translated to your language, the names and descriptions of activities are displayed in the user interface in your session language.

Note: When you create a new configuration, its definition language is implicitly set to your session language.



45- OVERVIEW OF MULTILINGUAL USER INTERFACE SETUP

Setting up the multilingual user interface in PPM involves the following high-level tasks:

1. Confirm that your database language semantics settings are correct. 

2. Deploy the language packs for the languages that you want supported in the PPM system.

3. Make sure that you have the following access grants:

-System: Submit Reports access grant. This is required to run the Translation Details and Translation Summary reports.

-Sys Admin: Manage Translations access grant. This is required to use the translation scripts (kExportAttributes.sh and kImportAttributes.sh).

4. Assess how importing PPM-provided content translations will affect your PPM system. Each language pack provides default translations for the generic configurations 

provided with each PPM installation. 

If you are working with a new installation of PPM, we recommend that you import all default translations before you start working on the system configurations for your 

business. 

However, if you are working with an upgraded PPM system, your enterprise has likely made significant configuration changes to the original generic content. In this case, the 

default translations provided for these configurations may not be fully relevant.

5. (Optional) Based on the results of your impact assessment (Step 4), import the portions you want of the PPM-provided PPM content translations for all deployed languages.

6. If you use Best Practices, assess and import the portions that you want of the default translations for the Best Practices content.

7. Perform configuration tasks as necessary, on an ongoing basis, after the installation or upgrade.

8. Going forward, as configurations are modified to support changing business needs,managing the added dimension of multiple languages becomes important. 

To address this, develop and implement a strategy for managing translations of the master data and translatable configuration entities for your organization.



46- WHAT IS MULTILINGUAL USER INTERFACE?

The multilingual user interface or MLU provides support for multiple languages  on a single instance of PPM. With the MLU, centralized management can roll out and maintain standardized 

processes and templates for use by resources across many different regions around the globe. And to support effective portfolio planning, central business planners can cut across language 

barriers and make sense of information rolled up from activities taking place in different regions.

You can set up and maintain the translations of your own enterprise configurations, in addition enabling your employees to interact with PPM in their own languages.

In addition to providing standard translations of static interface elements, the MLU approach in PPM is designed to facilitate the work of both business configurators and translators. 

From a business perspective, configurators can continue to define and maintain custom PPM entity configurations in their own language without having to worry about setting up duplicate 

configurations in different languages. 

With MLU support, a single entity can have multiple translations associated with it.

From the translation perspective, translators can export entity attributes, translate them into multiple languages using their favorite computer-assisted translation tools, and then import the 

translations back into PPM, 

where that can be associated with the original configuration entity. This means that you need only configure custom entities once, and configure additional translations as needed. 

Viewing and Working with PPM in MLU

After you deploy the language packs you need on PPM, each user must choose the language to use to interact with the system after logon. This becomes the session language, which remains in 

effect as long as the user is logged on.

To the extent possible, users see the PPM Center graphical interface (both the PPM Workbench and the standard interface) in the chosen session language. 

There are two main aspects to consider:

First, translations of all static text that is part of the PPM Center  boilerplate interface are provided with each language pack. 

Second, many custom form attributes (such as custom fields on requests) also support multiple translations. 



47- SECURE TOPOLOGY

The PPM Center platform is designed to be part of a secure architecture, and can meet the challenge of dealing with the security threats to which it 

could potentially be exposed.

Several measures are recommended to securely deploy PPM Center servers:

-Reverse proxy architecture

One of the more secure recommended solutions is to deploy PPM Center using a reverse proxy. 

PPM fully supports reverse proxy architecture as well as secure reverse proxy architecture. 

-SSL communication protocol

The SSL protocol secures the connection between the client and the server. 

URLs that require a secure connection start with HTTPS instead of HTTP.

-DMZ architecture using a firewall

The secure architecture referred to in this document is a typical DMZ architecture using a device as a firewall. 

The basic concept is to create a complete separation, and to avoid direct access, between the PPM Center clients and the PPM Center servers. 

This is especially important when opening access to PPM Center to external clients from outside of your organization.

-Server Cluster Hardware Load Balancer Configuration



48- REVERSE PROXY FOR STAND INTERFACE CLIENT (WEB CLIENT)

A reverse proxy is an intermediate server that is positioned between the client machine and the Web servers. 

To the client machine, the reverse proxy seems like a standard Web server that  serves the client machine’s HTTP or HTTPS protocol requests, with no dedicated client configuration required.

The client machine sends ordinary requests for Web content, using the name of the reverse proxy instead of the name of a Web server. The reverse proxy then sends the request to one of the Web servers. 

Although the response is sent back to the client machine by the Web server through the reverse proxy, it appears to the client machine as if it is being sent by the reverse proxy.

Reverse Proxy Security

A reverse proxy functions as a bastion host. It is configured as the only machine to be addressed directly by external clients, and thus obscures the rest of the internal network. 

Use of a reverse proxy enables the application server to be placed on a separate machine in the internal network, which is a significant security objective.

DMZ is a network architecture in which an additional network is implemented, enabling you to isolate the internal network from the external one.

Although there are a few common implementations of DMZs, this section discusses the use of a DMZ and reverse proxy in a back-to-back topology environment.

The following are the main security advantages of using a reverse proxy in such an environment:

-No DMZ protocol translation occurs. The incoming protocol and outgoing protocol are identical (only a header change occurs).

-Only HTTP or HTTPS access to the reverse proxy is allowed, which means that stateful packet inspection firewalls can better protect the communication.

-A static, restricted set of redirect requests can be defined on the reverse proxy.

-Most of the Web server security features are available on the reverse proxy (authentication methods, encryption, and more).

-The reverse proxy screens the IP addresses of the real servers as well as the architecture of the internal network.

-The only accessible client of the Web server is the reverse proxy.

-This configuration supports NAT firewalls.

-The reverse proxy requires a minimal number of open ports in the firewall.

-The reverse proxy provides good performance compared to other bastion solutions.

-Using a secure reverse proxy architecture is easier to maintain. You can add patches to your reverse proxy as needed.



49- COMMUNICATION CHANNELS SECURITY

PPM Center supports the following secure channels:

-Secure Channel: Between browser and PPM Center server

How to Configure: In general, trust is only needed on the client. 

This is a trust to the authority that issued the server certificate for the PPM Center server.

-Secure Channel: Between PPM Center and LDAP server

How to Configure: PPM Center connects to a LDAP server either in clear text or over SSL. 

-Secure Channel: Between PPM Center and mail server

How to Configure: PPM Center supports SMTP Authentication. 

PPM Center connects to SMTP Server either in clear text or over SSL. 

-Secure Channel: Between RP/LB and PPM Center server

How to Configure: Configure the PPM Server to accept ajp13 protocol. 

Setup the reverse proxy or load balance to use Secure HTTP (HTTPs) for outbound communication 

and forwards the request to PPM Server by ajp13 protocol.



50- CONFIGURING ACCESS TO A PROJECT TYPE

You can configure access to a project type to 

1-Control which users can make changes to the project type. 

2-Define who can use the project type to create projects. 

A-prerequisite: you must have the Edit Project Types access grant. 

B-To search for the project type, from the main menu, click Search > Administrative > Project Types, and click the project 

type name. 

C-In the top right corner, click More > Configure Access. 

D-In the Project Type Edit Access section, select who can edit the project type.

E-In the Project Type Usage section, select who can use the project type to create projects.

Note: Back to the Modify Project Type page, clicking More > View Usage, you can know which projects are using the 

project type. 

F-Click Save or Done. 



THANK YOU !


